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© Agilent Technologies, Inc. 2004

No part of this manual may be reproduced in
any form or by any means (including elec-
tronic storage and retrieval or translation
into a foreign language) without prior agree-
ment and written consent from Agilent
Technologies, Inc. as governed by United
States and international copyright laws.

Manual Part Number
E5813-90001

Edition
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Printed in USA

Agilent Technologies, Inc.
815 14th Street SW
Loveland, CO 80537

Windows is a US registered trademark of
Microsoft Corporation.

Warranty

The material contained in this docu-
ment is provided “as is,” and is sub-
ject to being changed, without notice,
in future editions. Further, to the max-
imum extent permitted by applicable
law, Agilent disclaims all warranties,
either express or implied, with regard
to this manual and any information
contained herein, including but not
limited to the implied warranties of
merchantability and fitness for a par-
ticular purpose. Agilent shall not be
liable for errors or for incidental or
consequential damages in connec-
tion with the furnishing, use, or per-
formance of this document or of any
information contained herein. Should
Agilent and the user have a separate
written agreement with warranty
terms covering the material in this
document that conflict with these
terms, the warranty terms in the sep-
arate agreement shall control.

Technology Licenses

The hardware and/or software described in
this document are furnished under a license
and may be used or copied only in accor-
dance with the terms of such license.

Restricted Rights Legend

If software is for use in the performance of a
U.S. Government prime contract or subcon-
tract, Software is delivered and licensed as
“Commercial computer software” as
defined in DFAR 252.227-7014 (June 1995),
or as a “commercial item” as defined in FAR
2.101(a) or as “Restricted computer soft-
ware” as defined in FAR 52.227-19 (June
1987) or any equivalent agency regulation or
contract clause. Use, duplication or disclo-
sure of Software is subject to Agilent Tech-
nologies’ standard commercial license
terms, and non-DOD Departments and
Agencies of the U.S. Government will
receive no greater than Restricted Rights as

defined in FAR 52.227-19(c)(1-2) (June
1987). U.S. Government users will receive
no greater than Limited Rights as defined in
FAR 52.227-14 (June 1987) or DFAR
252.227-7015 (b)(2) (November 1995), as
applicable in any technical data.

Safety Notices

A CAUTION notice denotes a haz-
ard. It calls attention to an operat-
ing procedure, practice, or the like
that, if not correctly performed or
adhered to, could result in damage
to the product or loss of important
data. Do not proceed beyond a
CAUTION notice until the indicated
conditions are fully understood and
met.

WARNING

A WARNING notice denotes a
hazard. It calls attention to an
operating procedure, practice, or
the like that, if not correctly per-
formed or adhered to, could result
in personal injury or death. Do not
proceed beyond a WARNING
notice until the indicated condi-
tions are fully understood and
met.
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E5813A Networked Gateway USB Hub

Introduction

The Agilent LAN/USB Gateway and USB Hub for Windows
uses USB over an IP connection, this goes beyond the
traditional five meter distance limitation between the USB
device and the host. Now USB instruments and devices may
be located anywhere on a wired or wireless LAN - without a
locally attached host PC. Since the host PC or server may be
located remotely, Agilent’s LAN/USB product enables devices
to be deployed in harsh or non-secure environments. This
Ethernet- attached solution provides five USB ports to
connect peripheral devices such as instruments, GPIB
converters (such as the Agilent 82357A), or general purpose
peripherals.

Cabling E5813A Networked USB Hub

To connect the E56813A Networked Gateway USB Hub to a
network:

1 Connect a standard Ethernet network cable to your
EH813A Networked Gateway USB Hub. Then connect the
other end of the Ethernet cable to a 10/100 BaseT switch
or hub.

2 Connect one end of the power supply* into the back of
the device and the other end into an AC outlet.

Power to this product may be supplied by a UL Listed Direct Plug-In Power
Unit marked “Class 2” or a UL listed power supply rated with a minimum
rating of 5V dc 2.5 A if used in the U.S. and Canada, or a power supply with
similar rating and approved by your local safety code if it is used
elsewhere.

E5813A Networked USB Hub



Installing the Drivers

E5813A Networked Gateway USB Hub

Note: Drivers may not have received “Designed for Windows 2000”
certification. If so, Windows displays a warning: Digital Signature Not
Found. While the drivers may not be Windows certified, they have been
thoroughly tested. Select “Yes” to continue with driver installation.

For Windows XP and 2000 Users

You must install the drivers using an account that has
administrative privileges.

1 Insert the “Agilent Driver” CD into your CD drive.

2 If the CD does not automatically start, then open the CD
folder and double click on the setup.exe program.

3 Select the “Install Drivers” button to start the install
process. There are multiple resources on the E5813A
which have to be setup, so follow all of the on-screen
instructions to complete the installation of the E5813A
Networked Gateway USB Hub.

After installing the drivers, the E5813A Configuration Utility
automatically starts so that you can configure the device.

Configuring E5813A Networked Gateway USB Hub

E5813A Networked USB Hub

For initial configuration, the device must be connected to

the same local area network as the configuration PC. Note
also that the E5813A Networked Gateway USB Hub cannot
function behind a firewall.



E5813A Networked Gateway USB Hub

In order to configure the device:

1 Launch the E5813A Configuration Utility from the Start
menu. The utility displays a list of discovered E5813A
Networked Gateway USB Hubs on your local subnet. A
new device has a default IP address of 0.0.0.0. You must
configure the device before it can be used on a network.

2 After the E5813A Configuration Utility has been launched,
it will reside in your system tray. To open the utility,
double click on the Agilent Networks icon in the system
tray. If you try to start the Utility from the start menu
and it does not launch, double-click the icon in the
system tray.

Fo i O] DL 7ime am
g L) E.a, 10 & Thursday
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> E5813A LAN,/USB Gateway and USB Hub Configuration Utility
File Edit Command Wiew Help

E5813A Networked Gateway USB Hub

=100 ]

sssse | = o
Configure Connect Event Log Feboot
El-glg Subnet 156.140.112.0 Mame: Agilent E58134
-6 Agilent E58134 [156.140112127]  [Ferial Number: Y 320F0218
MAC Addrezs;  00-20-BE-7F-02-18
IP Address: 156140112127
Subret Mazk: 2552552550
(3 ateway: 0.0.0.0
Debug Log: 0.0.0.0
DHCF: Dizabled
Boot Code: w132
Firrrmare: vl 40 47
H ardware: Rew B
Device (D: 003071
|l ptirme: 5 ming : B8 zecs
Status Available for Host Connection

Total Dizcovered: 1

Connected To Me: 0 Available For Connection: 1

Inlze: 0 Unoconfigured: O

E5813A Networked USB Hub

3 You can identify each E5813A Networked Gateway USB
Hub by its IP Address.
then the serial number can be used for identification.

If the device is not configured,

Unconfigured devices are listed separately. For example,
the device noted on the previous graphic with serial
number V320F0218 has not yet been configured.

4 To discover E5813A Networked Gateway USB Hubs on
other networks, see “Using the Configuration Utility

Program” on page 14.

5 Double click on the E5813A Networked Gateway USB Hub
or select the device and press the Configure button to set
the IP address, Subnet Mask, and Gateway.
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x

Device Mame: Clogze

Seral Humber:

| YA20F0218

AL Address:
| 00-20-BE-7F-02-18

P fddress;
| 186 . 140 . 112 . 127

Subnet M aszk:
|255.255.255. 0

Drefault Gateway:
| o .0 .0 .0

[HEF:
£ Enable.  ® Djzable

@dd to connection list

Debug Log Address:

[Optional. For technical support uze only)

|n.n.n.n

6 Enter a Device Name that easily identifies the E5813A
Networked Gateway USB Hub .

7 Enter the IP address and Subnet Mask. Contact your
Network Administrator for IP address assignment.

E5813A Networked USB Hub
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8 Enter the Gateway for your network. In a network using
subnets, the Gateway is the router that forwards traffic to
a destination outside of the subnet of the E5813A
Networked Gateway USB Hub.

9 To add this 5813A to your connection list, be sure to
check the box that is circled in red in the previous
graphic.

10 For the changes to take effect, you must choose the
Update button to reset the device.

heboo =

:) You will need ko reboot vour ES3136 LAMN/USE Gateway and USE Hub to complete the configuration process.
-

Wauld you like to rebook now?

E5813A Networked USB Hub



E5813A Networked Gateway USB Hub

Configuring Your Host PC

To configure a Host PC to access the E5813A Networked
Gateway USB Hub:

1

Launch the E5813A Configuration Utility from the Start
menu. The utility displays a list of all E5813A Networked
Gateway USB Hubs on your local subnet and on any
subnet configured in the Discovery List.

After the E5813A Configuration Utility has been launched
it will reside in your system tray. To open the utility,
double click on the Agilent icon in the system tray. If you
try to start the Utility from the start menu and it does
not launch, double-click the icon in the system tray.

The Configuration Utility automatically discovers E5813A
Networked Gateway USB Hubs on your local subnet. To
discover devices on other networks, you must add their
network address to the Discovery list. Select “Discovery
List” from the “Edit” menu. Add the Subnet addresses to
the Discovery List Manager. For example, to add the Class
C network 10.21.1, you must enter 10.21.1.255. Note that
your routers must be configured to pass subnet
broadcasts.

E5813A Networked USB Hub
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Discovery List Manager ] il

The Dizcovery Address Lizt dizplavs the netwark,
addreszes that will be searched for attached ES81 34
LAMAISE Gateway and USE Hubs. If you nio longer
wizh to zearch a particular network address, then
pleaze delete it from the Dizcovern Address List.

Cloze |
Digcovery Address List: Add
156.140.114.0 badify

Delete

Delete Al

ElE

4 When you have completed adding the subnet address to
the Discovery List, click on the Close button to save the
list. The screen will refresh within a few seconds.

E5813A Networked USB Hub
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=101 x|

File Edit Command View Help
E=gEas = o
Configure | Disconnect | Ewent Log Fehoot
=gl Subnet 156.140.112.0 M arne: Agilent E55134
5%; Agilent E5813A [156.140.112.12 [Fenal Number: 4320F0218
Elg% Subnet 156.140.116.0 MAC Addrezs:  00-20-BE-FF-02-18
5& Agilent ES813A [156.140.116.14 |F Address: 156140112127
Subret Mazlk: 250 2562650
(3 ateway: 0.0.0.0
Debug Log: 0000
DHCP: Dizabled
B oot Code: vl 3.2
Firrmare:; w1.40.41
Hardware: RHew B
Device 1D 0=0301
|lptirne: ¥ ming ;35 zecs
1] | _PI Status: Conrected ta thiz computer

|T otal Digooverad: 1

Connected To kMe: 1

Ayailable For Connection: 0 InlUze: 0 Unconfigured: O

5 Select a E56813A Networked Gateway USB Hub and press
the Connect button to add the device’s IP address to the
Connection List. The host computer then attempts to
connect to the device. For a list of the E5813A Networked
Gateway USB Hubs where you are currently configured to
connect, select “Connection List” from the “Edit” menu.

If you were able to configue the E5813A, but then were not able to connect
to it, the problem may be that you need a LAN *“crossover” cable instead of
the regular LAN cable.

6 The Found New Hardware Wizard prompts you to search
for the drivers: one time for the Remote Hub and two
times each for the USB Host Controllers and the USB

E5813A Networked USB Hub
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E5813A Networked Gateway USB Hub

Root Hubs. Select the “Install software automatically
(Recommended)” option and click the Next button. If you
get the warning message indicating that the drivers have
not yet passed Windows Logo Testing, choose the
Continue Anyway button.

The E5813A ships with the Driver and the

Automation- Ready CDs. The Driver CD software must be
installed for the product to operate. Once the Driver
software is installed, the E5813A should be attached to a
LAN, your PC should be able to connect to it, and the five
USB ports on the E56813A appear as additional Windows®
USB ports. These ports can be used by your PC to connect
USB instruments, general purpose devices, or converters
such as the E5805A USB to four port RS-232 converter or
the 82357A USB to GPIB converter. The Automation-Ready
CD with the Agilent 10 Libraries Suite allows you to use I/0
libraries (for example VISA, VISA COM, and SICL) to do
“instrument style” programming of instruments, devices, or
converters. It also provides a suite of tools for connection
management and interactive instrument control. If you are
using VISA or other T&M specialized software to program
instruments, or if you are using application software that
does instrument control, you may want to also install the 10
Libraries Suite.

So the correct 82357A drivers are accessed, the 82357A requires the
E5813A to have version 14.0 or higher of the 10 Libraries Suite installed.

11
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Uninstalling the Drivers

12

To uninstall the E5813A Networked Gateway USB Hub
drivers

1 Launch the E5813A Configuration Utility from the Start
menu.

2 Select Preferences from the File menu and click on the
Uninstall button. You must reboot your PC in order to
complete the driver removal.

E5813A Networked USB Hub
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Interpreting the Status Lights

The E5813A Networked Gateway USB Hub has 6 LEDs on
the front panel, the System Status LED and 5 hub LEDs.

Each LED is capable of displaying 3 colors, red, green, or
orange.

System Status Lights

On initial power up the system status LED is orange for 2
seconds while the system initializes; it then blinks green.

Hub Lights
Green hunting pattern across all LEDs Not connected to a host.
Orange alternating on ports 1-3-5 and 2-4 Updating image in Flash. Do not remove power from the
E5813A while flash is being updated. Doing so will damage the
E5813A.
Solid Green Hub port is powered.
Green over Red hunting pattern Please call the local Agilent support center. Locate a phone

number by checking http://www.agilent.com/find/assist.

E5813A Networked USB Hub 13
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Using the Configuration Utility Program

14

The E5813A Configuration Utility displays E5813A
Networked Gateway USB Hubs grouped by their subnet. The
Utility automatically discovers devices on your local subnet.
To discover devices on other networks, you must add their
network address to the Discovery list. Select “Discovery List”
from the “Edit” menu. Add Subnet addresses to the
Discovery List Manager. For example, to add the Class C
network 10.21.1, you must enter 10.21.1.255. Note that your
routers must be configured to pass subnet broadcasts.

=100 x|

File Edit Command WYiew Help
SESEES = 3
Configure | Disconnect | Event Log Rehoot
=gl Subnet 156.140.112.0 Marne: Agilent E581 34
5%5 Agilent E5813A [156.140.112.12 Senal Humber,  WE20F0213
E"ET& Subnet 156.140.116.0 MAC Address:  00-20-BE-7F-02-12
5& Agilent E5813A [156.140.116.14 |IP Address: 156.140.116.142
Subnet Mazk: 2552552550
(3 ateway:; 0.0.0.0
Debug Log: 0.0.0.0
DHCF: Dizabled
B oot Code: vl 3.2
Firmmware; w140 41
Hardware: Rew B
Device 1D: (0301
Ilptime: B ming ; 35 zecs
1] | _"I Status: Connected to thiz computer

|T otal Dizcovered: 1

Connected Ta Me: 1

Available For Connection: 0

Inlse: 0 Unconfigured: 0
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Preferences Menu Options

E5813A Networked USB Hub

File Menu: Preferences Allows you to disable or modify the
frequency in which the utility updates its discovered E5813A
list. Enables the logging of driver events to the system event
log and allows you to uninstall the drivers

Edit Menu: Connection List Contains the IP addresses of the
E5813A Networked Gateway USB Hubs where this Host PC
tries to connect. When an IP address is added to this list,
the Host PC immediately tries to connect to the device. If an
IP address in this list is deleted, all USB devices attached to
this E5813A are removed from this Host PC.

Edit Menu: Discovery List Contains a list of subnet addresses
of remote networks where the configuration utility searches
for Eb813A Networked Gateway USB Hubs.

Command Menu: Configure  Allows you to setup the TCP/IP
parameters in the device. You can also add this IP address
to the E56813A Networked Gateway USB Hub Connection List
by checking the Connect to this Concentrator (referring to
the E5813A) check box.

Command Menu: Connect Adds the IP address of the E5813A
Networked Gateway USB Hub to the Connection List.

Command Menu: EventLog Retrieves event information from

E5813A Networked Gateway USB Hub. Use this to gather
information for Technical Support.

Command Menu: Reboot Causes the E5813A to reboot.
View Menu: Driver Information Displays the version numbers
of the E6813A Networked Gateway USB Hub drivers and

allows you to uninstall the drivers.

View Menu: Refresh (F5) Updates the Discovered E5813A
Networked Gateway USB Hub List.

15
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Understanding E5813A and USB Hubs

16

Hubs, critical components in the plug-and-play architecture,
are wiring concentrators that enable the attachment of
multiple devices, thus converting a single attachment point
into multiple attachment points. USB architecture allows a
cascaded multiple hub configuration with certain power
limitations (explained later in this section). See figure 1.

PC
Host

Hubport

m 0000 (E=nA] [ Hubpor

( F5B13A | uaoimrea s ][ mner l[j[j[j

Figure 1

Each hub has an upstream port, connecting to the host, and
multiple downstream ports, connecting to downstream
devices, including other hubs. A hub can detect attachment
and detachment of downstream devices and enable and
monitor the distribution of the power to downstream devices
via their integral hardware and the operating system.

Each USB device reports its power requirements to the
operating system, which then enables and disables the device
as a function of its power requirements, and the amount of
available power. High-speed devices typically need to be
connected to a self-powered hub, which obtains power from
its external power supply and provides up to 500 mA for
each downstream port. Only simple devices, such as a
mouse, can be connected to a bus-powered hub, which
obtains power from its upstream host and provides up to
100 mA for each downstream port.

E5813A Networked USB Hub
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E5813A Networked Gateway USB Hub

Due to the limited available power for bus-powered hubs,
cascading two bus-powered hubs is an illegal topology, and
devices connected to the second hub will not function. (USB
specifications limit the connection of a bus- powered hub to
a self- powered hub or host only.)

According to the USB Specification, the maximum limit of
hubs cascaded in series cannot exceed five. In other words,
you may have a maximum of five hubs between any device
and the host. This does NOT mean that the maximum
number of hubs in a system is five. Indeed, up to seven
hubs can be connected parallel at any given level. You must
tally both external and embedded hubs when counting
downstream hubs.

The E5813A contains a self-powered USB hub and can be used to power
simple or high speed USB devices.

17
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Support

All support can be reached by contacting an Agilent call
center. For your nearest call center, go to
http://www.agilent.com/find/assist

18 E5813A Networked USB Hub
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E5813A Specifications

This appendix lists E5813A Agilent LAN/USB Gateway and USB Hub for
Windows Technical Specifications and Supplementary Information.
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E5813A Specifications
Technical Specifications

Technical Specifications

General Requirements

Minimum System
Requirements

Windows 2000 and XP Professional; USB port (OS may require more
resources)

Supported Standards

USB 1.0, 1.1, 2.0 compatible. USB 2.0 devices operate at 12Mbps

General Characteristics

Power Ships with 120/230vAC 60/50 Hz at 5vDC @ 3 Amps max
Maximum Power 15W
Connectors RJ45 Ethernet to five USB ports

Configuration

Remote configuration utility

Upgrades

Field-upgradeable software and firmware

IP Addressing

IP addresses from DHCP servers and static IP addressing are both
supported

Network Support

10/100 BaseT support

Device Status

LEDs for system and device status

Data Rates Data rates up to 12 Mbps per USB port
IP Addresses One IP address per unit
Downstream 500 mA downstream power per device

Server Support

Single and multiple processor servers supported

Units/Server

Up to eight units supported per server

OHCI

Two Open Host Controller Interface (OHCI) controllers

Event Log

Windows system event log for easy troubleshooting

Network and Device Recommendations

Network Utilization

Network utilization below 50%

Compatibility

Compatible with bulk or interrupt type USB devices; isochronous
devices are not supported.

Dimensions

Length, Width, and Height

11.05cm (L) x 18.29 cm (W) x 2.61 cm (H)

Weight

283.49 grams

Environmental Specifications

Appendix A 21




E5813A Specifications
Technical Specifications

Operating Environment

0°C to 60°C

Humidity

0% to 95% (Non-condensing)

22
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Agilent Technologies

DECLARATION OF CONFORMITY c E
According to ISO/IEC Guide 22 and CEN/CENELEC EN 45014

Manufacturer’s Name: Agilent Technologies, Incorporated

Manufacturer’'s Address: 815 — 14t st. swW
Loveland, Colorado 80537

USA
Declares, that the product
Product Name: Networked 5-port USB Hub
Model Number: E5813A
Product Options: This declaration covers all options of the above product(s).

Conforms with the following European Directives:

The product herewith complies with the requirements of the Low Voltage Directive 73/23/EEC and the EMC Directive 89/336/EEC
(including 93/68/EEC) and carries the CE Marking accordingly. This product is intended for use with ISM equipment.

Conforms with the following product standards:

EMC Standard Limit
CISPR 22:1997 / EN 55022:1998 Class B
CISPR 24:1997 / EN 55024:1998
IEC 61000-4-2:1995+A1:1998 / EN 61000-4-2:1995 4KV CD, 8 kV AD

IEC 61000-4-3:1995 / EN 61000-4-3:1995
IEC 61000-4-4:1995 / EN 61000-4-4:1995 0.5 KV signal lines, 1 KV power lines
IEC 61000-4-5:1995 / EN 61000-4-5:1995 2 KV CM. 1 KV DM

IEC 61000-4-6:1996 / EN 61000-4-6:1996 3V, 0.15-80 MHz, Mod 1 kHz, 80%
IEC 61000-4-8:1993 / EN 61000-4-8:1993 1 AIm, 50 Hz

IEC 61000-4-11:1994 / EN 61000-4-11:1994 Dips: 95% 10 ms: 30% 500 ms:

Interrupt > 95% 5 s

3 V/m, 80-1000 MHz

IEC 61000-3-2:2000 / EN 61000-3-2:2000
IEC 61000-3-3:1994 / EN 61000-3-3:1995

Canada: ICES/NMB-003:1998!2]



Supplemental Information:

U This product was tested in a typical configuration with Agilent Technologies test systems.

@ This Class B digital apparatus complies with Canadian ICES-003.
Cet appareil numerique de la classe B est conforme a la norme NMB-003 du Canada.

27 September 2004

Date Ray Corson

Product Regulations Program Manager

For further information, please contact your local Agilent Technologies sales office, agent or distributor.
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FI—=2 =+ 24 USBNTDA VA=V T LTLIEE,

RIANEA VA —)LT 2L, EB8I3A BEL—T « U T 1« HEHBINIC
BEL, TNAAZRETEEEICEDET,

bO—9 F—bU x4 USB/I\NTDEEE

WPIDRETIE, TNAARPC RCa—h)L V7 2y bIT—TIH
T ARENRHOET, T, EB8I3A v U—2 F—1+v x4 USB
NTET 7 AT I+ —IVONTRIEFEL VD THENRETT,

TINA AZFGET BIciE, LFOFIRZHFITLET,

1 [RZ—F ] A=a—h5 EBSI3A REL—T s VT r2EEILET,
A—FTaoVTo2EETHE, -V TRy FhSBHENT
E5813A v + Y= =1+ zA USB NTDY R MHERENE
T HLWTNARIKE, 774V EFDIP 7 FLA& LT 0.0.0.0 A
HOMTHENTVET, TS REZ, 2 FT—7 THAT Z1ICHRE
TERENDHDET,

T DB 7eeam
g 2 % 10 & Thursdary



1

E5813A %y b7 —9 5¥— bz A USB/\T

- E5813A LAN/USE Gateway and USE Hub Configuration UEility

3 EB8IBA HiEa—T VT ZEIMTRE, =T VT AT AT L
PLAICHETZXSICHDET, 2—T 0V T o ZRIIKIE, AT L
FLAAND Agilent 32w hTI—2D7 AV EZTIVIV v I LET,
[RA—=bF ] AZa—hba—T VT BEIHTERVESRE, VX7
L FUARDT AV ZETIVI ) v 7 L TLTIEEW,

=101 x|

File Edit Command ‘Wiew Help
sssse T
Configure Connect Event Log Rehboot
E‘"‘Eﬁ Subret 156.140.112.0 Name: Agilent E5ET 34
Q Agilent E58134 [156.140.112.127] Serial Mumber:  W320F0218
MAC Address:  00-20-BE-7F-02-18
IP Address: 186140112127
Subnet Mask: 2552562650
[3 ateway: 0000
Debug Log: 0000
DHCP: Dizabled
B oot Code: wl.3.2
Firrnmare: w4041
H ardware: Rev B
Device 1D: O=0301
|l ptirne: B ming : BE zecs
S batLz Ayailable for Hogt Connection

|T atal Digooverad: 1

Connected ToMe: 0 Available For Connection: 1

Inlze: 0 Unconfigured: O

4 % EB81I3A 2w bTU—2 F—b+wxA USB N7 IP 7 KL ATk
MTBTEHNTEET, TRAAPRESNTVEVEAIZ., YU T
He572ID L LCifTEEd,

ARBEDTNNA ZRZHNCERARENE T, e A Lo cid, Y
7VES V320F0218 OF /81 AR ELERESNTOER A,

E5813A % FT7—%2 USB/\T



E5813A %Y +FT7—2 =+ x4 USB/V\T 1

5 Hloxy hI—2ichHb EB8I3A v b U—2 F—bk Uz A USB /N
TEBETZHECOVTIE. 14 R—YD FEa—F 4054 - 70
T LD 2B LT ZEW,

6 EB813A %v h7—% #—FuxA USB NTEZTLIUY$3
M 773 AR LT [Configure (3b5¢)] K& > %21 v 7 L, IP
7RLA, 7%k RRY, F— bz A RRELET,

E5813A v FT—% USB/\T 5



1

E5813A %y b T7—9 ¥— b x A USB/\T

x

Device Mame: Cloze

Senal Mumber:

| WA20F0218

AL Address:
| 00-20-BE -7F-02-18

|P Addressz:
| 156 . 140 . 112 . 127

Subnet Mazk:
|255.255.255. 0

Default G ateway:
| o .0 .0 .0

[THIER:
|Vf" Enztle. % Dizable

@dd to connection list

Debug Log &ddress:
[Optional. For technical support uze only)

|n.n.u.u

7 EB813A v FU—2 S —FUxA USB NI ZBHISHRITE S &K
ST INA A% ASILET,

8 IP7RFLAEY TRy b AT ZANILET, IP 7 FLADEID YT
KDOWTIE, 2y FT—IEREICHEL TIIEE N,

E5813A v 77— USB/\T



E5813A %y b 7—U 5— b4 USBINT 1

9 Xy I DT = T2 AZANLET, T2y FAALTVS
3y FI—=U0HH, F—+FU A& EB8I3A v FU—2 F—F
T x4 USB NT DY T3y hOWERICH B5U5EIC T T v & 726K
TEHNV—ZTY,

10 C 0 EB813A Z izt VY A MiBINY 212id, i\ — Y OmmE | TH/RALD
foleFzy s Ry 7 AT AH L TIEEN,

M ZHEGHCT S, [Update (BH )] R VEEIRLTT /N, A%
Uty FLTLEEW,

x4

\ii)' Wou will need ko reboot wour ES3134 LAM/USE Gatewayw and USE Hub o complete the configuration process.
-

W'ould wou like to rebook now?

E5813A %v F7—%2 USB/\T 1



1 ES813AXRY bI—9 5—boxAUSB/INT

FA F PC DE

EB813A %y +FI—2 =1+ Yz A USBNTILT VL ATES XS ICH
A+ PCZET %I, UTFOFIHZIATLET,

1

[RZ—F] A=a—h5 EB8I3A RELI—T VT s ZEHLET,
A—F 4 )T ZEETRE, a—Hh)L TRy FEE, BHY AR
GENTWBEY T2y b EDEB8I3A xv FI—0 F—b+T A
USB NI WX TERENE T,

E5813A WiE1—7 4 V7 4 &I T 5 L, 1—F 1 VT 1 ET AT L
FPLARHEESTSXSICBDET, =TV T4 ZHIKIE. ¥ AT
L FLAWO Agilent ©7 A AV R XTI w7 LET, [ A2~} |
AZa—5aA—T 4 UT 4 ZRHTEHVEAIE. YATLH FLAN
DT AAVERTIVIV YT LTLEIWD,

REL—F VT 41k > T, A=AV $T %y b 10 EFS13A % v
FT—% =k x o USB ATAHBIKICHINENE T, Bl
T—7 LOTFNA A BIBT I, ZO 3y bT—2 7 KL A EKH
YA MEMLUEY, [Edit (#%#:)] A=2—»5 [Discovery List
BV AN ZRIRLET VT2 bOT RLAZEKREY X b < 32—
TrIBMLES, Izl V75X C DRy hU—7 10.21.1 B
md 33, 110.21.1.2551 EANILET, Y7 xv b Ju—FFv X
FZEBREE LK — 2 ERETZRHENDH S LITHEELTLE
XU,

E5813A % FT7—%2 USB/\T



E5813A %Y +FT7—2 =+ x4 USB/V\T 1

Discovery List Manager El

The Digcovery Address List displays the nebwork,
addreszes that will be searched for attached E58134
LAMAUSE Gateway and USE Hubsz. If you no longer
wizh to zearch a particular network. address, then
pleaze delete it fram the Dizcoverny Address List.

Cloze |
Discovery Address List: Add
156.140114.0 b odify

Delete

Delete Al

Ele

4 73y 7 RLAZKRIY A MaEmMLES, [Close (IL%)] R
227Uy LTYAMZRELR T, WMIONFIBR TEREN
S

E5813A v FT—% USB/\T 9



1 ES813AXRY bI—9 5—boxAUSB/INT

- 7 E5813A LAN,/USE Gateway and USB Hub Configuration UElit

=100 ]

File Edit Command Wiew Help
. B

Configure | Disconnect | Event Log Rehoot

=gl Subnet 156.140.112.0 Name: Agilent E5E134,

5%5 Agilent E5813A [156.140.112.12 Serial Mumber:  320F0218

EIEE Subnet 156.140.116.0 MAC Address:  00-20-BE-FF-02-18

5%; Agilent EB8134 [156.140.116.14 |IF Address: 156140112127

Subnet Mazk: 2552552850
[ ateway: 0.0.0.0
Debug Log; 0.0.0.0
DHCF: Dizabled
Boot Code: v].3.2
Firmmare: v1.40.41
H ardware: Rewv B
Device ID: 00301
| pirne: ¥ minz ; 35 gecz

1] | ﬂ Statuz: Connected to thiz computer

Connected ToMe: 1 Awvaillable For Connection: 0 InUsze: 0 Unconfigured: O

IT atal Digcovered: 1

5 E5813A v bTU—2 F—F+2 x4 USB N7 =E#ERL, [Connect
(BH REEZIZVY I LT TNNAAD IP 7 RL A& A M
BMUET, FAN TV Ea—2DTF NS ANOEHZMITLET, B
TEHEHDREEN TS EBS8I3A v FI—2 F—+ 7 x4 USB 7\
TDVY A MeFRd %icid, [Edit (#)] A=2—7»5 [Connection
List (¥t A )] ZRIRLET,

EB813A Z&8RE LIcH R CELLIFAIE. BED LAN 7—7)LHbh)
ICLAN TNy F1 7—TIVHBRETHZAREMLSH Y E T,

10 E5813A % FT7—%2 USB/\T



E5813A v FT—% USB/\T

E5813A %Y +FT7—2 =+ x4 USB/V\T 1

6 HLLUN—FRT 27 DOMIY P — R TIE, FIANOMRZERT S

A=Y NERENET, UE—F NTIZDOWT 1 [, USB KX b
aviru—35& USB )b—F NI ZNFNUTDONT 2 [ Ay E—IN
FRENET (VI MY T ZHEMCA VA M—)LT 5 (#E2)] 4+
YavEBIRLTC [XN] K22V 7 LET, RIANH
Windows 0 d 57 A MCEKL TWERWT LB RTEE X vy E—IH
FRENS, [FT)REVEIVY I LET,

E5813A 1icid. RIANCD & A—r A= a7+ CDAMMIEL
TVET, ABREMHTZICIE. RSANCD DOV T T7ZmAY
A=V RBRENRHVET, FIAN VT T T2A VA=)V
L7zt%kic. EB813A % LAN Ic##i L C. PC A EB813A Ic#iTZ
32Xk %9, £/z. EB81I3A ® 5 DD USB K—L+H
Windows® DiEfit USB R—k & LTSI NET, ThH5DFR—F
&, USB #&#s., WA 7/3 1 X, EB805A USB-RS232 I /\— %,
82357A USB-GPIB a2 NN—XIcHHTAT-DIHEHTEE T,
Agilent 10 Libraries Suite (& hizA—rA—va LT+«
CD 233 &, /O 514751 (VISA. VISA COM. SICL %% &)
EHEALUTHER. TNNAR, ANN—207a75 LEERTEET, C
O CD KR EREESA VR T7T ¢ TERBERHEOISDY—)b
Yy FEFENTVET, VISA ®Z0fthd T&M EHY 7 v =7 %
FRHLTTOT S L2ERT 250, BaRklEziT> 7 7V r—yay
VI b T EEHT 5512, 10 Libraries Suite 4 > A b—)b
THELETEET,

82357A %fERAT 31HS. ELL 82357A FSANHBT7 VLR ENB i
(3. E5813A (T 10 Libraries Suite /\—Y 3>~ 14.0 U EHI X F—IbEA
TWBHELHHYVET,

"



1 ES813AXRY bI—9 5—boxAUSB/INT

FSANDT ALV X =1V

EB813A v rU—20 F—1+UxA USB NTDRSANET VA VA
b=l 92123, UTOFIHEZRITLES,

1 [RAZ—F ] AZa—05 EBSISA EL—T 1 U T« ZEFHLX T,

2 [File (77 4)V)] A=a—»5 [Preferences (FEAE )] Zi#IR L,
[Uninstall (7> A > A =) BEVEZ Y w7 LET, FTA 10
HIbRZ5E 79 %1cid. PC ZHEHIT 08N H D £9,

12 E5813A % FT7—%2 USB/\T



AT—RR 5T DA

E5813A %y b7 —Y 5=tz A USB/I\T

1

E5813A v + TI—2 F—hrvxzA USB NTicid,. 7a v b %)V EIC
6 D0 LED (VA5 L A7—% A LED, 5 D0D/\7 LED) %9 %9,
% LED &, 7%, &k AL vYD 3 sk LES,

VATLARAT—BRRA ST

BFRZRINICANS L Y AT LBWIIHEENTOSR, Y AT L A7 —4%
A LED % 2 BiiA L2 ST U, KISkEEO I LD Y £,

NI S07

BREDNELSHEITERT DL S ICRT
A=k 1-3-b & 2-4 BREICH LY I Bl

BelcsT
FREOLZREDHD SHZETERT BK DR

E5813A v FT—% USB/\T

RAMCERENTOE A,

TSV AADA A—IEBFRTT, 75 v 10OEHPITER
EBOBREA ZICLBEVTLIEEN, BREFJICT S &, &R
KBEHIRIELET,

NT R— FDOERHF /IE>TVET,

BEHEYDHARAZRI £V RICTEELEEWN, ARET £V 2DE
#&5ElE. http://www.agilent.co.jp/find/assist TTHERRL F2ELY,

13
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BWEI—Ta4UTa 707

14

E5813A %y b7 —9 5¥— bz A USB/\T

> LO{EA

E5813A E1—7 4 VT4 Tk, ¥ 7 v b ICHI—T{tEhiz
E5813A v +I—2 F—r DA USBNTHERENET, 2—F 7
V74l &> T, =l 7%y b EOTFTNA AWHBIICHITE N E
T DRy FT—7 LOTINA ZAZMINT 31CiE, 203y FT—2 TR
L AZRHHY A MTBIML T, [Edit (FHfE)] A=2—»5 [Discovery
List (MY A 1)) Z#RLE T, ¥ 7%y b7 FLAZHBIHY A+ =
F=TXITBMLET, 22, V5ACHORy FU—7 10.21.1 %38
g s, 110.21.1.255) L AN LEY, ¥ 7%y b Jo—FFy X+
B ERES XN —RERET HRHENH ST LICERLTIEETY,

- 7 E5813A LAN/USE Gateway and USB Hub Configuration UEilit

=101 x|

File Edit Command Yiew Help
e o
Configure | Disconnect | Event Log Rehoot
=gl Subnet 156.140.112.0 M ame: Agilent E58134
5%9 Agilent E5813A [156.140.112.12 [3enal Mumber:  VE20F0213
Elng Subret 156.140.116.0 MALC Addrezz:  00-20-BE-7F-02-12
& Agilent E5813A [156.140.116.14 |IP Address: 156.140.116.142
Subnet Maszk: 255255 2550
[3 atewan: 0.0.0.0
Debug Log: 0.0.0.0
DHCF: Dizabled
Boot Code: v].3.2
Firrnware: v1.40.41
Hardveare: Rev B
Device 1D: (0301
|| ptirme:; 8 minz ; 35 zecs
1| | _PI Status: Connected to thiz computer

IT::utaI Digoovered: 1

Connected To Me: 1

Availlable For Connection: 0

InUse: 0 Unconfigured: 0

E5813A % FT7—%2 USB/\T




E5813A v FT—% USB/\T

E5813A %Y +FT7—2 =+ x4 USB/V\T 1

BXRBEAZ2—FTV3>

[File (7 7 11V)] #=2— - [Preferences (E&RE)]

RIS NTEMEBROY A N2 2—T 4 VT A BEFTZHELRETH LT
D, BHEMHNCLUIEDTEET, /oo YATL ANV BJICRIA
INARY M2l TES LI LD RIANZT VA VA=)V LT2D
TEEY,

[Edit (¥R )] *=2— - [Connection List (&5 X )]

KA+ PC otk EB8I3A v b I—2 7— b+ x4 USB 2
TOIP 7 FLANERENK T, BV A M IP 7 FLAZEIMT 5 &,
HFAL PCRIQIETNAANOEGZRITLET, YA IS IP T
FLAZHIBRT 2 &, EREBICHRHI SN TVSETXTO USB 7731 AW
FRA L PC hSHIRENE T,

[Edit (%R )] *=2— - [Discovery List (U X } )]
REL—T 4 VT 4h EB81I3A xv U=V F—ro 1 USB NT %
MKTBVE—F XY T—=TDY TRy b 7 RLADEREINET,

[Command (3= F)] A=2— - [Configure (5&%E )]

TINA ZAD TCP/IP NS5 A—27%z#HELET, [Connect to this
Concentrator ( T OHEMEEFEICHER T2 )] Foy 7 Ry 7 A%4 L
T. IP 7 RL A% EB813A v v U—7 F—b w1 USB N7 Dk
VAMGEBMT B ENTEEXT,

[Command (3<% F)] X=2— - [Connect (%%)]
E5813A v hU—27 F—b+ oz A USBNTDIP 7 RLRZHEHY X
MEBIMLUED,

[Command (IR F)] A=a2—-[EventLog (TR F O%)]
E5813A v b I—2 F—rvx A USBNThHhHARY MEWRARISL
9, Fffiv R— Mo BERERIE, COA > a vEMHLUTISELE T,

[Command (3<% F)] X=2— - [Reboot ( BiEh)]
HEREEZHET L XS,

[View (%7 )] *=2— - [Driver Information ( K51 /\1&R )]
E5813A v v U—2 F—+D x4 USBNT DRI ANDN—T 3 UF
BRERLET, £le. RIANET VAV AF—IVTEET,

[View (&R )] #= 21— - [Refresh ( E#7)] (F5)
Wit E iz EB81I3A 2y FU—7 F—F+vxA USB NTDYRFZIE
MLET,

15



1

E5813A %y b7 —9 5¥— bz A USB/\T

EB813A & USB /\ DWW T

16

TITT7VRT VA T—F T FyOEREIAVKR—2Y FTHEINTI,
PR A PR OVFERIRA > MITEHL, D T3A DK%
AIAEIC T BHEMIEETT, USB 7—F 77 F v Tlk, (TDXE I a VT
AT %) —EDENHIRELE - 72 h 27— RO )VF INTHER AV A]
BT, K1 ZBRLTIZE,

PC
Hiost

Hubport

m mﬁ[jm[ A | [ Fppor

[(E5BI3A | [mevmmms i | e l[j[j[j

1

BT, RAMCHHITET Yy TA MY —L F— b XY VA Y=L
TNNA R (MDONT ZEE) IS 2EBDXY VA Y —L K= DD
DET, NTRET VAP =L TINA ADOHHRB XTI A Lzt L.
BAN—FI 27 BLCARVL =T 1 2 F VAT LBHTOXY VA
V=L TNRAZNOE G2 AN LT, ZNZ2HEHRLET,

% USB FNNA ZARBREL T B EN AR —FT 4 VT AT LITHE L
ARV =T 4 V5 VAT NI ERE ) L MHEERE NI T T, TN
A AEIMEE IS U E T, SBT3 RdE, LT - U —
R« NTICHERIT 2RELNH D ET, TOFHDONT &, YHBEBERT X 7%
WOENEZT, X TV A MY —L R— MKk 500 mA OFE#EAE
LET, NA - NT—R - NTIHEHRTEZDIE. IUAGREDESTINA
ADHTY, :@fﬁﬂ@/x?‘ti Ty TARY =L KA D SENEZT.,
BRET AR =L R— Mk 100 mA OEHEHHELET,

E5813A % FT7—%2 USB/\T



E5813A v FT—% USB/\T

E5813A %Y +FT7—2 =+ x4 USB/V\T 1

INA = NT—F - NTTHHTEZBNEIRENTVE 7S, 2 DDNK -
INT—FR - NT DA R — REHUIIERI T, 2 BHONT IR S NTzT7N
A ABHEBEL F 8 A, (USB OILEETIZ, /NR < 8T — R « NT DR %E
BT« INT—=R - NTERIIRZAFDAICHIELTHET, )

USB Ofthkic &% &, B AT — P TR, ik b BDNT Z it U T
BT BHENTEEY, DED, TRAALKRA M EDOMICEKR B BDONT
ZHHTEERT, T, AT LEBIBZNTORKEN b BETHE LW
IERTRDD FHA, HRCE, EOLNVICBWTEIRK T HDONT %
WH|THRTEE T, XU VA MY —L NTORUE, ST ENBNT D
W52 ZD T ET 20 ENH D £,

ES813A (V7 - INT—F USB N\ TZ&EHE L THY . &% USB 7/31 X
FreldmR USB 7/ ANDOENHHEICFERTEE Y,

17



1 E5813A %y +T—2 5F—boxA USB/\T

BR—+b

PE—FARELBEAIR. HAZT LU RICTHKELTEED, BEODH R
2 kv ZOHEIX, http://www.agilent.co.jp/find/assist T Zhif
BLIEEW,

18 E5813A v 77— USB/\T



E5813A Dtk




E5813A {1tk

ZOfFERiciE. E5813A Agilent LAN/USB #°*— k7 1 /USB /\7 (Windows f)
DEAiTERRS S URRIBROEZHENTVE T,

22 18 A



E5813A mft#k
it

Btk

—HREM
RN AT LEH Windows 2000/XP Professional, USB R—
(OS IT& > TIKIBINY YV —ZAHHBE)
byt USB 1.0. 1.1, 2.0 B#:, USB 2.0 7/\1 X% 12 Mbps TEE
—RRAFIE
BR AR DRI 120/230 Vac 60/50 Hz (5 Vdc. &Kk 3 A)
aAxI4B RJ45 Ethernet ~ USB /R— k (x 5)
e JE—FREI—TAUTA
7y FIL—F VIEILITETT—LI T ETA—IVET v T L— FalgE

IP7FLADEYWHT

DHCP 5 —/\p5D IP 7 FLRLEE IP 7 FLADEAFZE T R— b

v bT—=U DY R—

10/100 BaseT & HR— k

TINARADAT—2 R

LED TYRTLBLKUT/NA ADAT—2 A %ERR

T—=%2 L—F 1USB R— bt HfcW) &K 12 Mbps

IP7FLX KEB1BIC1D20IP7RLZR

HOVA M) —L TINAZX 1 BICDES00 MA DA TR M) —LEH
F—NOHFR—+ VI oty ERIVF TOLy G ESYR— b

EE/ TN 15— NICDERK 8 BDEBEETR— b

OHCI 2 £® OHCI (Open Host Controller Interface) 3> tO—>
ANV~ 0Oy Windows ¥ X7 L AN b AT %ER LT, MEZEGRICHRETEE

WEIZRY PT—VETINMR

xv b —UERE

50% K

Btk INVIERRE feld A > 2 —F 7 M EriXdD USB 7 /31 RITHS.
7 AV OF REERIEIER S

&

REXEX®E 11.05cm x 18.29 cm x 2.61 cm

g8 28349 75 L

T A

23



E5813A Dft#k

i
B
BFES 0°C ~ 60 C
BT 0°C ~ 95 C (FHEE)

24 1A



